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Video in Photoshop 

In this lesson, we’re going to learn about basic video editing in Photoshop. In 
a previous lesson, we talked about the video features in Lightroom, which are 
pretty limited. Video editing in Photoshop is nice because, after you learn basic 
editing, you can also incorporate other Photoshop features like 3D, Layers, Text, 
etc. into the videos. 

Setting up Photoshop for Video

We use a lot of different features when working with video in Photoshop, so we’re 
first going to focus on the workspace. First, click on the Window menu at the top 
of the screen, choose Workspace and then make a note of which workspace is 
currently active. The workspace saves interface elements like the locations of the 
panels on your screen. You’ll want to remember which workspace you currently 
use because we’re going to change things up quite a bit for working with video. 
You’ll want to be able to return to your regular settings later. Then, use that same 
menu to choose the Motion workspace. 

The Motion workspace will change up your interface, adding the Timeline panel at 
the bottom of the screen. This it the panel designed to work with video. 

Load video files into Photoshop

We’re going to load video files into Photoshop from Adobe Bridge. In Bridge, 
navigate to the folder containing the video file[s]. Click on one of the video files 
to make it active and a preview will appear larger within the Preview panel. If 
the Preview panel is not visible on your screen, click on the Window menu and 
choose Preview panel. Below the preview, you will see some play settings. There 
is a little slider that you can drag in order to quickly preview the contents of the 
video, but know that in order for this slider to work, you first need to click the 
triangular play button. 
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Bridge can be useful for video in that it can combine multiple video files into a 
single Photoshop file. That’s what we’ll do in this lesson. 

Normally, double-clicking on an image file within Bridge will open that image into 
Photoshop. With video files, double-clicking on the file will open it in whichever 
your default program is for video. For me, that program is QuickTime, and that’s 
not what I want here. You can change the default video program from within 
Bridge’s Preferences. Click on the Bridge menu and choose Preferences. (In Win-
dows, this can be found under the Edit menu.) Within the Preferences dialog, 
click on the “File Type Associations” menu on the left side of the dialog. This will 
allow you to choose which programs will open specific file formats. For example, 
if we wanted Photoshop to automatically open all AVI video files, we would click 
on the AVI format and then change the application menu to the right to Adobe 
Photoshop. If Photoshop does not automatically appear in the menu, we’d have 
to choose the “Browse” option and then manually navigate to the Photoshop ap-
plication on the hard drive. 

In Bridge, we are 
looking at a folder 
of video files. We 
clicked on one of 
the files to see a 
preview on the 
right. We hit the 
Play button be-
neath the preview 
and are using the 
slider to quickly 
preview the video.
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Note that it’s not necessary to set a default video-editing program. You can al-
ways open a selected video file (or files) by choosing Photoshop from the Tools 
menu. If you want to open multiple video files into a single Photoshop document, 
click on the Tools menu and choose Photoshop > Load Files into Photoshop 
Layers. Photoshop will open and every selected video file will be loaded as a 
separate layer in a single Photoshop document. In the Layers panel, there will be 
a filmstrip icon in the bottom right corner of the thumbnails, indicating that the 
layers are video layers. These videos will also be shown as separate layers in the 
Timeline panel. The Timeline is essentially a copy of the Layers panel. If you were 
to change the stacking order of the layers, it will also change the stacking order 
in the Timeline panel. If you change which layer is active in the Layers panel, it will 
change the active layer in the Timeline panel as well. 

Know that you can zoom in and zoom out on the Timeline just like you zoom in 
and zoom out on a map. Simply click and drag on the slider bar at the bottom of 
the Timeline panel and you will see the video bar[s] expand and contract. You will 
also see the time units at the top of the Timeline change to reflect the expanded 
or contracted view.

Within Bridge’s 
Preferences, we 
clicked on the File 
Type Associations 
category. Here, we 
can click on a spe-
cific file format and 
determine what 
program should 
default to open 
that format.
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Editing Video in Photoshop

Mute the sound If you have loaded multiple vid-
eo files into a single Photoshop document, you 
might want to mute the sound so that it’s not 
overwhelming when they all play at once. Mute 
the audio by clicking the little speaker icon in 
the settings bar above the Timeline layers. 

Reposition clips The layers in the Timeline panel work in the same way as the 
layers in the Layers panel in that the top-most layer will completely obscure your 
view of the layers underneath it. You can, however, click and drag on the video 
layers to reposition them so that they start at different times. In the video exam-
ple, we dragged the four video layers so that they would play one at a time, with 
one video beginning when another ends. 

Multiple video files were opened into a single Photoshop document. You can see the files 
within the Layers panel as well as within the Timeline panel at the bottom of the screen.

Click the Speaker icon to  
mute/un-mute the audio.
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Trim video The playhead han-
dle can be found at the top of 
the Timeline and you can drag 
it back and forth to preview the 
video and specify what part of 
the video you want to work on. 
To trim a video clip, position the 
playhead at the location where 
you’d like to cut the video. Click 
on the video clip to make it ac-
tive (it will have a white outline 
around it) and then click on the 
scissors icon above the video 
layer list. This will split the clip 
into two parts, and you’ll see 
that another layer will be added 
to contain the second part. Make sure that the piece you want to delete is the 
only one selected, click on that second part (the part you want to trim away) and 
then tap the Delete key. 

Four video clips are loaded as different layers. We are dragging the clips to position them in 
the Timeline so that they play one after the other. 

We placed the playhead in the spot where we wanted 
to split the clip and then clicked the Scissors icon. As 
a result, the clip split into two pieces, each on its own 
layer.
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In the video example, this left us with an empty canvas for the duration of time 
that contained the deleted clip. That’s because there were no other video layers 
playing at the same time. We fixed this by dragging one of the other video layers 
so that it started when the trimmed video ended. 

When you delete durations of video from the Photoshop Timeline, know that 
you’re not actually deleting anything. You’re just hiding parts of the clip and you 
can always bring them back if you want. To bring the deleted part of a clip back, 
hover your cursor over the edge of the clip until your cursor looks like a bracket 
with two arrows coming out of it. Then click and drag on the edge of the clip in 
order to expand it again. 

As you drag the playhead around to work with your video, you might find that it 
tries to snap into position. This is because it’s trying to help you by snapping to 
meet the start/end point of another layer. If you don’t want this snapping to hap-
pen, hold down the Ctrl key as you drag the clip. 

In the video example, we continued to preview the various video clips, trimming 
away the boring parts and then repositioning the clips so that they play consec-
utively. We’re trying to create a video that contains birds in motion. 

Click on a video clip in the Timeline and the layer containing the clip will auto-
matically become active in the Layers panel. In the video example, we clicked on 
the various clips and renamed each layer in the Layers panel so that they all have 
distinctive names. When you change the name of a layer, it will also change the 
name in the Timeline. When you change the stacking order in the Layers panel, 
it will also change the stacking order in the Timeline. In the video example, we 
stacked the layers in the order that we want the clips to play. After doing so, we 
had to manually drag each clip within the Timeline so that it plays in the correct 
order. Note that we can move more than one clip at once by holding the Shift key 
to click on multiple clips and then dragging all of the selected clips as one chunk. 
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At the top of the Timeline, you might notice a line made out of little blue specks. 
This represents the video that Photoshop has cached, or stored in its memory. 
The parts that Photoshop has cached will preview much smoother than the parts 
it hasn’t. When you play the video from the Timeline, it will cause all of the parts it 
plays to become cached. Tap the Play button at the top of the Timeline panel to 
play the video, starting at the location where the playhead is positioned. Alterna-
tively, you can use the Space Bar as a shortcut for playing the video. 

Limit project length Photoshop will play your video until there are no clips left 
in the Timeline, but you can manually limit the length of your project if you want 
a specific duration or if you don’t want it to include empty area or hidden layers. 

We renamed all of the layers and those new names are reflected in the Timeline panel. We 
then placed all of the clips in sequential order so that they play one after the other. 

The line made out 
of blue specks rep-
resents the parts of 
the video that Photo-
shop has cached.
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Specify how long you’d like the video to be by clicking and dragging on the 
gray slider handles that appear directly beneath the time stamps at the top of 
the Timeline. There will be a slider handle at the beginning and at the end of the 
Timeline. Drag these handles to specify the start time and end time of the video. 
In the video example, we left the first slider at the very beginning of the timeline 
because we want to include the clip that is located there. We dragged the end 
slider in a bit so that it only includes the clips we want. We had a hidden clip at 
the end that we didn’t want to include, so we dragged the slider so that this hid-
den clip wasn’t included in the video duration. 

Keyboard shortcuts for video

When working with video, there are some keyboard shortcuts that you can en-
able that aren’t usually used outside of video. To enable these, click on the “ham-
burger menu” in the upper right corner of the Timeline and choose “Enable Time-
line Shortcut Keys.” This will not cause problems when working with the rest of 
Photoshop because the shortcuts are only enabled when the Timeline is visible. 

Space Bar: Plays video starting at playhead location

Up and Down Arrow Keys: Jumps to the beginning or end of the selected clip. 
If nothing is selected, the arrow keys will jump the playhead to the beginning or 
end of the project. 

Left and Right Arrow Keys: Moves back and forth through the video slowly, a few 
frames at a time.

Left/Right Arrow Keys + Shift Key: Moves back and forth through the video in 
increments 10x larger that using the arrow keys alone. 

*If you’re used to using the Arrow Keys to nudge a layer (to change its position), 
know that you can still do that but you need to hold down the Command key (Ctrl 
on Windows) while doing so. 

Use the gray 
slider handles 
set the start and 
end locations for 
your video.
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Working with the Audio of Individual Clips

Each clip in the Timeline will have a little square icon with a triangle inside of 
it. It’s located in the top right corner of the clip. Click on this icon to get some 
additional settings. In the settings box that pops up, you can switch between 
Video and Audio. When you click to view the Audio settings, you’ll see that 
there is a Volume slider that allows you to determine how loud the selected 
clip should play. The Fade in and Fade Out sliders allow you to gradually fade 
the clip’s audio in or out so that it doesn’t begin or end abruptly. Mute the clip’s 
audio all together by turning on the “Mute Audio” check box below the slider 
settings.

Video Speed Settings

The settings box you accessed 
by clicking the square icon in 
the top right corner of the clip 
will also provide you with some 
video settings and this is where 
you can choose to speed up or 
slow down the selected clip. 

We clicked on the icon 
that looks like a square 
with a triangle inside to 
access these additional 
settings. Click on the Au-
dio option to adjust the 
volume of a selected clip.

Click the video icon to access settings for  
speeding up or slowing down the clip.
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Transitions

By default, there are no tran-
sitions between clips. They 
will abruptly change from one 
clip to the next as the video 
plays. You can add transitions 
by clicking the transition icon 
at the top of the Timeline 
above the list of clips. (It looks 
like a box that’s half black, 
half white.) A box will pop 
up, containing a list of tran-
sitions. With the exception of 
the Cross Fade transition, all 
of the transitions can be applied to any clips. Drag one of the transitions into the 
Timeline and hover the cursor over the beginning or end of a clip. When you see 
a black box appear, release the mouse button and the transition will become at-
tached to the clip. 

When a transition has been applied to a clip, you 
will see a little ramp at the beginning or end of 
the clip bar (depending on which end you at-
tached the transition to) and this shows where 
the clip will be fading in or out. Note that you can 

click and drag on this ramp in order to shorten or 
lengthen the fade-out or fade-in. 

If you use the Fade transition to have a clip fade out, the clip will become more 
and more transparent, revealing any layers positioned beneath the clip. If there are 
no visible layers beneath the clip, then it will fade out to show the transparency 
checkerboard. This is what happened in the video example. We don’t want that, 

LEFT: We clicked the 
Transition icon to see a 
list of transitions.

ABOVE: We’re dragging 
one of the transitions to 
the start of a clip. The 
black box indicates we 
can release the mouse 
button to place the 
transition.

We’re changing the duration of 
the transition by dragging the 
end of the transition ramp.
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so we dragged the next clip so that it 
overlaps this clip by the same amount 
of time that the transition takes up. 
This makes it so as one clip ends, it 
fades out to reveal the next clip. This 
overlap is not necessary if you are us-
ing the Fade with Black or Fade with 
White transitions because there is no 
transparency involved. 

Grouping Videos

We already mentioned that you can click to drag clips back and forth, positioning 
them in a certain order in the Timeline. Well you can also place more than one clip 
on the same horizontal bar. When you do this, all of the clips placed on the same 
bar will be placed inside a Video Group within the Layers panel and the Timeline. 
When more than one clip is grouped like this, they will never be able to show up 
at the same time. To ungroup one of the clips, drag its thumbnail outside of the 
group within the Layers panel. To ungroup all of the clips, right-click on the name 
of the group in the Layers panel and choose “Ungroup Layers” from the menu 
that pops up. 

The Fade transition was applied to the top clip 
so we positioned the bottom clip to overlap so 
that we never see any transparency.

Here, you can see that two clips were placed on the same bar and in the Layers panel, you 
can see that those two clips were placed into a layer group. 
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When two videos are grouped together and placed in sequence, you can use the 
special transition, called “Cross Fade.” This will cause one video to fade out while 
the other video fades in, creating a really smooth transition between the two. To 
apply this transition, click on the Transition icon and then click and drag on the 
Cross Fade transition, positioning it right between the two clips. 

Adding Audio

At the very bottom of the Timeline, there will be a layer called Audio Track. This 
is where you can place a music file. If you don’t already have any music tracks, 
you can search for one online by searching for Creative Commons Music. This is 
music that you are allowed to use in your projects (for free) as long as you give 
attribution to the artist. 

When two clips are 
placed on the same 
horizontal bar, you 
can use the special 
Cross Fade transi-
tion. We used that 
here.
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Scroll down to the Audio Track in the Timeline and click on the little plus sign icon 
( + ) on the far right side. This will open your browser so that you can navigate to 
the folder containing the audio track. Choose the track and click the Open but-
ton. The song will appear as a green bar within the Audio Track layer in the Time-
line. You can trim the audio by clicking and dragging on one side of it to make 
it smaller. In the video example, we trimmed the audio file to make it the same 
length as the video. Click on the square icon on the right side of the green audio 
bar in order to get some extra settings, including Volume, Fade In and Fade Out. 

You may want to make an audio track quieter for a period of time when there is 
something interesting going on in the video. To do this, split the audio clip in the 
same way that you’d split a video clip (by placing the playhead and then clicking 
the Scissors icon). Then, change the volume of the isolated piece of audio. Note 
that when you use the Scissors icon to split something, it’s going to split every-
thing that is intersected by the playhead, placing the individual pieces on their 
own layers. You can clean up the Timeline after doing this by dragging two halves 
of a clip onto the same horizontal bar, placing them into a layer group. 

A music file was added to the Audio Track layer and we are trimming it by dragging the end 
of the track to the left.
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Additional settings

There are some more settings available at the top of 
the Timeline, above the clip list. The icon on the far 
left ( |< ) will place the playhead at the beginning of 
your project. The second and fourth icons ( <|  |> ) will 
move the playhead backwards and forwards one sin-
gle frame at a time, which can be useful for precision editing. The triangular Play 
button will play the video. The Speaker icon will mute/unmute the audio. 

Click the little gear icon to access the resolution setting. By default, this setting is at 
100%. If you have a computer that isn’t really designed to handle video, you might 
want to lower this resolution setting in order to speed up the performance. The 
quality of the video won’t be as high, but the playback will be better. When you ex-
port the video, it will always be exported at the highest quality. This resolution set-
ting is only going to affect things when you’re working on the video in Photoshop. 

Beneath the Resolution setting is a “Loop Playback” check box. When this is 
turned on, the video will play in a continuous loop, starting over from the begin-
ning after it reaches the end. 

To the right of each clip name 
(in the Timeline) is an icon 
that looks like a filmstrip with 
an arrow next to it. Click on 
this icon to access a menu of 
settings. From this menu, you 
can add media to the cho-
sen line of video. You can also 
create a “New Media Group,” 
which would add an empty group, to which you can add layers. Choosing the 
“New Media Group from Clips” option would create a new group and include all 
selected clips inside that group. 

Additional settings are found 
at the top of the Timeline.

Click the icon to the right of each layer name to access a 
different group of settings.
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The “Replace Footage” option will allow you to replace the video with a different 
clip from your hard drive. The “Delete Track” option will remove the video layer. 

At the bottom of the Timeline are some num-
bers. The number in parentheses will tell you 
the frames per second of the video you’re 
currently working with. The middle number 
indicates where the playhead is currently po-
sitioned in the video. You can also click and 
drag left and right on this number to move the 
playhead back and forth. You can change how this playhead position is displayed 
by holding down the Option key (Alt on Win) and clicking on the number. Doing 
this, you can switch from minutes/seconds to the number of video frames. 

The button that looks like a right-pointing arrow is what you can use to share the 
video by saving it out in a different file format. The button on the far left (that 
looks like three squares) will convert the video to a frame animation, which would 
allow you to work on the individual frames, one at a time. This is not an option I 
would use very often. 

There are also some video options available in the Layer menu. Click on the Layer 
menu and choose Video Layers. A submenu will appear with several options.

Exporting a video from Photoshop

When you’re finished working on your video in Photoshop, you’ll probably want 
to export it in a format that is viewable in other programs. Click on the little Share 
icon at the bottom of the Timeline. It looks like a curved, right-pointing arrow. 
The Render Video dialog will appear. At the top, you can rename the video and 
choose the location on your hard drive where you’d like it to be stored.

The numbers at the bottom of the 
Timeline represent the playhead loca-
tion (left) and the number of frames 
per second (right).
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Use the Format menu to decide which video format the file should be saved in. 
The most common is H.264 and that’s what I use. The Preset menu will change 
all of the settings below to reflect that preset. There are different presets that are 
optimized for specific uses and you’ll likely want to choose one of these to suit 
your purposes. 

At the bottom of the dialog is the Range setting and this is where you can decide 
if you only want a part of the video to be exported. If you don’t want the full video 
to export, you can choose the Start Frame and End Frame here. If you choose the 
Work Area option, the exported file will only include the area that you specified 
using the gray slider handles near the top of the Timeline. 

The Render Options deal more with video that includes 3D, so we can ignore 
those here. 

Click the Render button to export the video and create the new video file. 

Specify your export settings in the Render Video dialog, accessed by clicking the icon at the 
bottom of the Timeline that looks like a curved, right-pointing arrow.


